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BEST PRACTICES COURSE – ArchiCAD 17 - Using AC 17 New Building 

Materials for Clean Sections and Detailed 3D Models 
 

Hello, this is Eric Bobrow.  In this ArchiCAD video tutorial, I will teach you how to use the new building 

materials in ArchiCAD 17 to create clean section drawings and beautifully detailed 3D models.  So here 

we have a new file created from the U.S. residential template.  So this is what Graphisoft ships out with 

ArchiCAD in the United States.  And I'm going to go and create a box of walls using the default wall 

settings.  Then I will switch to interior walls here and do a couple of walls. Switch from the exterior wall 

that was set as the default and pick an interior partition wall just to get started. Then I'll draw a simple 

set of a couple of walls here and complete them.  [0:00:57] 

When I go to 3D, you'll see as we would expect the building model. But as I zoom in we'll see a little bit 

more detail than we had before.  You can see that each of these walls when I zoom in further you can 

see how the walls now show up; their edges show up with the composition in 3D whereas previously 

they did not.  Now let's put a slab on here.  So I'll go to the slab tool and use default settings for the slab 

and place this to the outside face by clicking quickly here and go to 3D.  You can see the top of the slab is 

some type of a carpet texture here, and when I rotate around, you can see that the outside of the slab is 

showing more detail.  In fact, it's rather odd.  It's showing the framing space and then the underlay and 

the carpet is sticking all the way out there.  [0:01:52] 

So that's rather odd and not going to be what we want.  We need to learn how to control that.  Now if I 

cut a section through this here, we'll see what's going on in a little bit clearer detail. So when I open the 

section, you can see that the slab has all of these composite skins, and it's sticking all the way out to the 

edge of the wall.  What about this new thing in ArchiCAD 17 where it's supposed to clean up these 

intersections automatically?  The first thing I'm going to do is select the slab and look at the settings 

here that are brand new in ArchiCAD 17 allowing me to set the height. This is the zero height relative to 

the current story. Either at the top, the bottom, top of core or bottom of core.  Let me switch it to the 

top of core and you'll see how the slab instantly repositions itself. [0:02:49] 

So the top of the subflooring, which is the core here, is now at the zero.  And guess what?  This outer 

wall now sticks into it.  In fact, if I select the slab you can see this dot indicating that the slab does stick 

out here, but the wall had priority because these interior surfaces or skins and had lower priority. 

Basically they are made out of something softer or less strong compared to this.  If we go to 3D, we're 

going to see a slight change.  This has now lost the carpet and we're only seeing the framing and the 

underlay. Let's say we wanted to make this match the exterior. I can select this and go to what used to 

be the materials.  Now it's called surfaces.  [0:03:37] 

When I press down on the paintbrush, you'll see that I can override the surface.  Instead of it being done 

by the building materials which are showing the various skins, I can override this. As soon as I do that, 
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the entire slab, at least the part that was the model extended out, is now a single color.  If I'd like it to 

join or merge in, I would pick the same color, the default walls exterior color that was used by the walls.  

So now we have a nice clean result.  However, when I go back to the section, it has not changed at all 

because really that was only affecting the surface appearance of the outside there.  So let me just undo 

that back a couple of steps and let's clean it up a different way that in general would be preferred for 

ArchiCAD 17.  [0:04:30] 

Let me go back to that section and let's take a look at this wall.  This wall here, if I would like it to have 

the outside material extend down then maybe I should take the bottom of it and use the standard pet 

palette and extend it down perhaps to the bottom of the core or bottom of the skin.  Now this slab is 

actually something that has a little bit of sheathing at the bottom. It's really intended for interior like a 

floor and ceiling combination.  But let's ignore that for now and clean that up later.  Let me take it all the 

way down to here, but look, nothing happened. Why? Because these materials here are not as strong as 

the underlay. They are being blocked there.  How do we know what they're made from and what 

strengths they have? [0:05:22] 

If I select this I can right click on it and there's a new command in ArchiCAD 17 saying "Edit Selected 

Composite". It allows you to select a composite like a wall or a slab and instantly see the settings for the 

composite.  Previously, we would have to go to the Options, Element Attributes, Composites and 

manually find the one that that was selected; now it goes directly there.  Now we have the generic 

interior and generic exterior material. We have a couple of skins that are part of this.  Each one of them 

has some built-in settings for its appearance and its strength.  Now let's take a look at the floor 

composite and use the same shortcut.  By the way, under this command here, it's saying "Edit Selected 

Composite".  I use the keyboard shortcuts in the work environment and added a shortcut.  So I can 

actually use Shift+Ctrl+C to open that up.  [0:06:32] 

And you may want to create a shortcut for this because it's such a frequently used tool as far as I'm 

concerned. You can see here that we have carpet and rubber and underlayment.  This would be the 

structural underlay; and wood i-joist. So we have this gypsum board down below. Now how do we know 

the strength of these things? These things here are part of the new category of building materials.  So 

each one of these you can see has a fill and an appearance in terms of the surface.  One thing I would 

like to see here is the ability to see the strength of this particular material in the composite structures. 

We can't see it here; we have to go to the Options menu, Element Attributes, Building Materials where 

we can see the underlayment and wood I-joist.  [0:07:29] 

Now if you look closely you will see that these are highlighted. In fact all of the building materials that 

are used in this particular composite are highlighted because I have that selected.  It's a great time 

saver.  So we can see the wood I joist, the main framing have a particular strength, 560.  So that is 

stronger than some things. For example the gypsum board is 300 so it's less strong.  Now to be able to 

compare or modify them I'm going to select them both at the same time because it will allow me to see 
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all of the building materials.  Remember the wall was generic exterior and generic interior.  The exterior 

is set for 530, the interior for 590. That is a bit odd, because exterior as far as I'm concerned should be a 

higher value.  In this case, the main thing is that it should be higher than the underlayment and the 

wood I joist if we want it to have priority.  So let's take this exterior material and take it up to 630, then 

it's just a little bit above the 625 of the underlayment. [0:08:39] 

 When I say OK, we are going to see this instantly changes the intersection.  Now let's not worry about 

the gypsum board underneath here, let's look at what happens on the outside as well.  If I go to the 

outside you can see how this actually has corrected here. I only did one wall, and I want to do all of 

them.  Well, there are a number of options that we can do. If I undo this here and go back to the section 

and take this back up here, let me demonstrate another option that we have.  We can select this wall 

and slab and go to the Edit menu. There's a new command under Reshape that says "Adjust Elements to 

Slabs".  This allows us to take walls and adjust their bottom or the top or both.  In this case I might take 

it to the bottom of the core, or just to the bottom of the whole thing.  Let me take it to the bottom of 

the whole thing and we'll see what happens.  [0:09:48] 

It tells me that it's adjusted one of one elements. And you can see how it's gone down like that.  Now 

the reason why I wanted to show you that is that I can go to the 3D window.  And then can select all of 

these exterior walls here and do the same thing. In fact I can select them and go to the Edit menu, 

Reshape and say Adjust Elements to Slabs, and then go ahead and find the slab down below.  You can 

see all four elements were adjusted like that.  And I go back to that section, we'll see that it's not only 

cleaned up here but it's cleaned up over on this side as well.  In the middle, notice that this already is 

cleaned up.  Why?  Because this wall was set to rest at the zero level and the slab is set to have the zero 

level be the core.  So the wall is sitting on the structural part of the slab and its gypsum board is slightly 

stronger than the carpet and the rubber underlay.  So that's why it's cleaning up without any extra work. 

[0:11:00] 

Now let's take a look at what happens if we were to stack walls to make a multi-story building.  So we're 

going to go back to the floor plan and I will go to the wall tool, select all walls, and then I will Shift+click 

to select the slab.  I'll copy and go up a story using the keyboard shortcut up arrow or Ctrl+up arrow.  I'm 

now on the next story up.  And I paste, and you can see now that we have on this upper floor the same 

layout.  And when I go to 3D we see the building has gotten taller and looks nice. When we go to that 

section using the keyboard shortcut F6 to go to the section you'll see that it's already done some 

cleanup here.  It may not actually the complete, but it's done much more than what ArchiCAD used to 

do before version 17.  [0:11:52] 

If I select the slab, you can see it's actually sticking out here, but it's giving way because the walls have 

higher priority.  There is something a little odd here.  This wall framing is stopping at the gypsum.  So the 

gypsum here should actually stop at the surface. And perhaps we should have some interior gypsum on 

this as well.  So what is causing the problem?  The issue is that this wall that I copied down below was 
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extended all the way down to the lower part of the slab and this lower wall, even though its handles 

point up here, is giving way to the upper wall.  So it's basically stopping because the upper wall comes 

down here. And because this upper wall is breaking at the underlay here, the gypsum is continuing.  So 

what we want to do is select this wall and adjust it.  [0:12:50] 

Another way that we can do this is the Edit menu, Reshape, Adjust which does have a built in keyboard 

shortcut of Command or Ctrl+ - (hyphen or dash).  And then I can click, you'll notice the funny cursor on 

the slab, and then say I'd like to adjust the bottom of it to the top of the core.  So that will be right up 

here at the underlay. When I do that you'll see how this highlighted wall now stops at - and in fact this is 

the base of the story - and the lower wall, which was already going up here now is allowed to continue 

up here. And the drywall or the gypsum board has stopped.  So now we have a cleaner result.  Still there 

are a couple things that I would like to adjust about this.  [0:13:43] 

One is that we perhaps want to have some gypsum board on this wall. So let me select this and 

remember I will use that keyboard shortcut to edit the selected composite.  You can also just right click 

on the wall and open it up. You can see it has generic exterior and generic interior. If I click here it will 

bring up this popup menu. But I can click here and I will select it and not bring up the popup.  I found 

that to be a useful shortcut. Let me insert a skin and change this to the gypsum board and make it 

perhaps an appropriate thickness. You can see it has just a skin. Always the top or first item will be the 

main reference, so it will be the outside of the wall going towards the inside, or the top of the slab going 

down towards the bottom.  [0:14:42] 

Let me just say OK.  I'm redefining this wall type, which means all walls both down here and up here and 

on the other side over here have this drywall.  And you can see that this has cleaned up.  Now again, we 

have the issue where this wall, even though it would like to go up, is being blocked by the upper wall.  

Let's take a look in 3D and see if I can select all of these upper walls here. I don't remember which one is 

which that I've done, but I'm going to use the Adjust command.  Remember we can use the Adjust with 

the keyboard shortcut Command+dash or Ctrl+dash. Click on the slab right here in 3D and say take it to 

the core top.  And three of four were adjusted. Why?  Because one of them had already been done.  If I 

go back to the section you can see now this drywall is wrapping around.  [0:15:42] 

So basically by changing the definition of this composite to add the gypsum, it's now cleaning up 

automatically in all of the sections.  So every section would clean up, which is wonderful.  Now finally 

this structural slab, instead of stopping and hanging from the inside of this wall, it may rest across the 

top depending upon your construction method. So how would we make that happen?  Let's select both 

of these again and go to the Options, Element Attributes, Building Materials where we can inspect all of 

the ones that will be highlighted.  Remember the generic interior material was set up with 590, and that 

has higher priority than the I joist which are the ones for the slab.  Now we could change the interior 

material to be lower and that would work, but what I actually prefer is to be specific about this. 

[0:16:43] 
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I am going to take this wall and do my shortcut for editing the composite and change the generic interior 

material, instead of being generic, let me choose to make it wood framing.  If I do that, it has a material. 

If any part was exposed, but it also changed its priority level. I might also want to be more specific about 

its thickness here. Let's say that instead of 6 inches it's going to be 5 1/2 because it's a 2x6, something 

like that. That makes the wall slightly thinner and when I say OK you can see how this cleans up 

beautifully.  This wood framing here got a little thinner and has a lower priority. So it's now cut by the I 

joist and the actual wrapping here automatically adjusted because this element actually is colliding with 

the other one, and ArchiCAD is cleaning up that intersection.  [0:17:43] 

So ArchiCAD is doing a tremendous amount of work to make these sorts of intersections work. You can 

adjust priorities and which components are within which elements. In other words I changed the 

definition of this wall type, and therefore because the interior core is framing rather than generic, it now 

intersects differently.  Now one more thing we'll take a look at is we've got this building with certain 

story heights.  If I go and change the story heights - and my favorite way is to right click in the view map 

or the project map on one of the floor plans and say "Story Settings", that's a quick way to get to the 

story settings.  And then I can go and maybe take the lower story here and boost it up. I'll boost it up a 

couple of feet.  So let's just say OK.  [0:18:37] 

Notice that the story reference line went up and the entire building went up.  And when I go to 3D the 

whole thing just grew beautifully, no gaps.  In previous versions of ArchiCAD, there would have been a 

gap.  The story line would have gone up, the upper elements would have gone up, but the lower walls 

would not have changed.  Now how did this get taken care of in ArchiCAD 17?  This slab here, if we look 

at it, is set at a certain height - zero - in relationship to the second floor.  So it moves up in relationship 

to the floor. The walls, much like they would have before, have their base set on that upper story, that 

second floor. But new in ArchiCAD 17 is that walls and some other elements as well can be locked in on 

both bottom and top.  [0:19:32] 

So this is saying that the bottom is locked in a small distance below the reference line. Actually it's going 

down 1 foot and 5/8 inches, so it's going down to the bottom here. But more important in terms of this 

demonstration is that the top is linked to the second floor, the upper story, and it is set at zero.  What 

does that mean?  It means that if this story moves around the top of this wall will adjust. The top of the 

wall doesn't have to be at zero, it can be at some other value, just like the bottom. But it's still linked to 

that story.  So whatever that offset is, whether it's zero or something else, when that story height 

changes it will change. You can see here this is the way that ArchiCAD defaults to, and it's nice because if 

there is a story above it will link the top of it to that story for automatic adjustments. [0:20:26] 

Let's do one more thing here. Let's say we don't have a basement. So this is going to be something with 

a foundation or perhaps it's going to be a slab on grade.  So I'm going to switch it.  First of all, what 

happens if I change it to a different type of flooring? If I change it to a wood floor 2x10 instead of 2x12 

it's going to have a thinner amount of framing. You can see that the part that stayed constant here was 
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the top of the core.  Remember I had locked that in saying it was the core top.  Now it seems to have 

some extra skins down below so this is intended as some type of ceiling structure here.  And what 

happens if we put it as concrete slab on gravel? Now we can see that it's something rather different.  

We have this concrete here, and then we have some space down below.  But perhaps we want to do a 

wood floor over concrete slab, giving it even more complexity.  [0:21:43] 

When we do that, we bring up a few different issues.  So the top of the core is the top of the concrete. If 

we look at this, and I'll open up the composite, here is the structural concrete which is the core. And 

then we have air space up here followed by subflooring.  And these are not core, and they're not 

finished. The top here, the cherry, is the finish.  So this line here is the line that is at the top of the core.  

Now because ArchiCAD's new option allows us to have the top of the core be the reference line, it 

adjusted the whole thing.  That could be just fine but I'm going to actually take it down. I'm going to drag 

this down so that now the top of the subfloor here is at the zero.  [0:22:48] 

So then we have the finished floor on top of that.  You can do it whatever way you want. You'll notice 

that this now is saying that its top of core is a small distance below the story.  You can do that any way 

you want.  We do have an issue in terms of this whole intersection here.  The outer skin of this wall is 

not passing through.  Now it's possible we could adjust the priority and force it to go through, but we 

might want to actually pull the slab back in so that the core goes down.  So let's see how that works.  If I 

zoom into any part of this and I select that slab, you can see it's sticking all the way out to the end.  If I 

go to the corner and use the option to offset the entire outline, this entire outline could go in or out the 

same distance.  Let's take it 2 inches in here.  [0:23:48] 

And if we go back to that section, we're going to see that ah, this wall is now going all the way through 

and the slab is actually stopping at the face of framing here.  So that's certainly an interesting way to do 

it.  We might want to then take this wall and say that we would like to pull it back up to this height here.  

What is a little odd is that I just did one wall and there's another wall on the back end here. So we would 

want to do all of them.  But this slab doesn't show a line.  Why is that?  It puzzled me at first and then I 

looked up the composite. I opened it up and found that the slab has a gravel fill at the bottom and 

there's no contour line.  So that's an option for composites in this case to say don't show a line on the 

bottom of the gravel because it's not going to be a hard edge, it's going to be lying on top of the graded 

soil. [0:24:47] 

So this is just fine. The other problem that I am finding is that we're not even seeing this. We're seeing 

something about the concrete and we're not seeing the gravel.  So let's look at the definition of the 

building material.  We're going to go to the Element Attributes, Building Materials with this one 

selected. And you can see down here gravel fill is one of the ones that is highlighted. It says that it's 

going to have a fill in section of gravel fill, which makes sense, and a 3D of sea river rock 04.  Now in 

order to be able to clean this up fully, let's make all of these walls the same. I'm going to move this wall 

back down and go to the 3D and we'll take all of the exterior walls here. [0:25:37] 



 
 

Best Practices Course – AC17 New Features Part 2 – © copyright 2013 by Eric Bobrow 

Maybe I'll just rotate around and select them. I now have all four walls like that.  And let me pull them 

up. So I'll go here and see if I can stretch this up.  Let me take it up first to the home story. Now that 

exposed this shape and I will take it down to perhaps where it snaps to the bottom of the concrete. 

What are we seeing down here?  That is the underside. So this is the slab on grade that we are seeing, 

and we are seeing this dark color here. If we rotate around I think that we'll see - if I'm lucky enough to 

get that, there we go - it was the color. You can see this is rather dark. It's that funny rock, that river 

rock. [0:26:39] 

We have two issues here.  One is that this doesn't look like gravel, and the other is that in that section, 

we're not seeing this lower area.  So remember that if I went to the Element Attributes, Building 

Materials I could see that this was using the gravel fill. And the gravel fill as a building material had this 

particular fill, this particular material. Let's go now to the appearance of it.  Now building materials are 

what you make things from. Surfaces in ArchiCAD 17 are the old materials; it's what they look like. So if 

we take this surface that was river rock 04, we can see that it's got a texture here that gives it a certain 

appearance of stones, river rock. But this image, I think this is one story high, about 8 feet high from 

what I recall calculating it at one point. [0:27:39] 

These rocks are rather large. I have found by a little experimentation if I took them down to 4 inches 

which is about a tenth of the size of the single image here, 1x1 would be only just a few inches here. 

That would be 10 cm across.  You can see what that does here.  Actually, I don't want to change it for 

the river rock, because I might want to use that. I am going to duplicate it and give it a name, "Gravel 

Fill". So now in the copy I'm going to go ahead and change this to the smaller grain and say OK.  Then I'll 

go to the Element Attributes, Building Materials and say that gravel fill here uses, instead of the river 

rock, it uses the new gravel fill that I just created.  So this says that in 3D, the surface appearance by 

default will be - let me go to 3D - this smaller version that looks much more appropriate for a gravel fill. 

[0:28:57]  

Now remember in this section we're not seeing this down below. Why is that?  It turns out that if we go 

to the fill types and we find the one that was used here, which was 31 gravel fill - and by the way, these 

numbers are used in the U.S. because they match the construction specifications institute standards, but 

in international versions you might have similar names but without the numbers.  In any event, what I 

found is that the spacing here for paper, if I zoom out a little bit, you can see that there are some dots.  

But the spacing is rather too large, so I'm going to take it out to a much smaller size here. And I did some 

experimentation, but I found that this actually gave me a reasonable value. So I've just changed this for 

any time I use gravel fill and say OK. [0:29:53] 

And now if I zoom out, you can see that the gravel fill is starting to show up properly.  It turns out if we 

go to the View menu, Onscreen View and make it a true line weight we can see how that is starting to 

look for a drawing.  So there may be more things that you want to tweak but right now we have a 3D 

view that shows the gravel if it was exposed. And maybe we would never expose it on the outside of the 
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building because we have terrain. But you know that we can do something like a marquee here and if 

we had a marquee and we looked at that maybe we would be seeing the gravel underneath. Here is the 

other thing that is a very nice option to know about. Right now, you can see everything that's being cut 

through as this dark uniform appearance.  This is controlled under the View menu, Elements in 3D View, 

Filter and Cut Elements in 3D.  [0:31:08] 

And one of the options that you can do is switch to show cut surfaces with element attributes.  You can 

also switch to make it another color like red, and you can see then that this is going to have a little 

different graphic appearance. That can be very nice for certain presentations. In this case, what I'd like 

to demonstrate that we can choose to use the element attributes and then if we zoom in or out it 

refreshes. You can see that we are seeing the skins; it's a rather interesting way to do that. And here is 

the gravel. So we are cutting through this and getting a rather easy to understand cutaway of how this 

building is going to be put together. I think this is a good point to finish up this tutorial.  This has been 

Eric Bobrow. I look forward to getting your comments and questions on the page down below. Thanks 

for watching. 

[END OF AUDIO 0:32:19] 


